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I. Starting of EE 2000 

De-Installing the software 

Before you can install the new software, you must remove any older version of this software. 

1. Click on Start in the task bar and choose menu Einstellungen1 and click on Systemsteuerung 

 

2. Double click on the icon Software  

3. Select the icon Programme ändern oder entfernen and select the list entry of this software: EE2000 

 

4. Choose command button Ändern/Entfernen 

                                                      
1 This Document and the software are created on a German version of Windows XP. All windows messages in this 
document are written as they appear on the screen and are not translated to the English language. 
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During the de-install procedure you will be asked whether to de-install some shared files or not. You can delete all files. 

Installing the software 

To install the new software follow the steps 1 to 2 as described above. 

Choose command icon Neue Programme hinzufügen 

 
3. Insert the EE2000 CD-ROM into your CD-ROM drive and press CD oder Diskette. 

A setup boot program starts and temporary installs some necessary files to continue with the real setup program. The 
setup program asks you for the path, where the software files are written to. 

By default this is C:\Programme\EE2000. 

Hardlock Driver Installation 
After finishing the setup program, you have to install the Hardlock. The Hardlock (also called a Dongle) is a small device, 
which can be plugged on any parallel port of your computer. Optional the Hardlock is a small device which can be 
connected to an USB port. If the Hardlock driver is successfully installed, a red LED at the USB Hardlock will light on. 

Run [CD]:\Driver\Hardlock\Hldrv32.exe on your EE2000 CD-ROM.  

Follow the instructions on the screen. 

Starting EE 2000 

EE 2000 includes all of the programs: bioScan 2000, eeScan 2000, eeScan 2000 (Henkel), eeScan 2000-RL, 
AIDA 2000, PyroScan 2000, and Riss 2000.  

To start EE 2000  

1. Click on Start in the task bar and choose menu Alle Programme and sub menu EE2000 

2. Double click on the menu entry EE2000  

 

The following picture is shown during the start-up procedure to indicate the activated program version: 
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Error message during start up: 

 
You didn't plugged the Hardlock to your computer or the Hardlock is plugged to a port, which address isn't declared in 
the SET HL_SEARCH= statement in your AUTOEXEC.BAT file. 

A printer, who is connected to the same parallel port as the Hardlock, may produce problems, if the printer is powered 
off. (for example Hewlett Packard HP5MP) Disconnect the printer, or power on the printer. Or use another port for the 
Hardlock. 

If you have any problems, call Mr. Michael F. Opheys: +49-171-6918844 or send an e-mail to: DrOpheys@EE2000.de. 

If you click on Nein / No, the software starts in ‘Demo Mode’. The Demo version is limited: no hardware support (only 
‘dummy hardware’), images and worksheets can not be saved, opening film and worksheets is limited to max. 20 frames 
resp. 20 rows. 

Hardware Installation 

To use all functions of EE 2000, it is necessary to install the required hardware: 

- video capture card (grabber interface) or digital camera  

- digital I/O interface 

- D/A converter interface 

- A/D converter interface 

 

To install an interface card follow the instructions in the ReadMe.txt file on the driver disk, coming with the interface. 
Normally you have to run Setup.exe from the driver disk. In some cases it is necessary to reboot the computer after 
installing of the driver. Select the interface in the Setup menu of the EE 2000 program. 

 



EE 2000 I - 7 

 

 

Table of supported hardware: 

Video Capture Cards 

Interface Name Bus Type Driver Model OS 

Video 1000 S/W ISA16 WinRT Device #0 all 

SensiCam PCI Driver from the manufactory, PNP all 

PixelFly PCI Driver from the manufactory, PNP all 

Video for Windows compatible 
capture cards: e.g. Bt848, Win TV 
(Hauppauge), ELSA Winner 
2000/Office, Asus, etc. 

PCI or AGP Driver from the manufactory, PNP, 
Control via AVI API-functions 

see the 
manual of 
the interface 

USB 2.0 Digital Camera USB Driver from the manufactory, PNP WIN2000, 
XP, Vista 

 

Digital I/O interfaces 

Interface Name Bus Type Driver Model OS 

Fpc-024 ISA8 WinRT Device #1 All 

Rtx-02d ISA8 WinRT Device #1 All 

PCI-DIO24, PCI-DIO24H PCI WinRT Device #1, PNP All 
 

Digital to Analogue Converter 

Interface Name Bus Type Driver Model OS 

FPC-011 ISA8 WinRT Device #2 All 

RTX-03B ISA8 WinRT Device #2 All 

AX-5621 ISA8 WinRT Device #2 All 

ISODAC 16 - Uses a Digital I/O interface All 
 

Analogue to Digital Converter 

Interface Name Bus Type Driver Model OS 

FPC-011 ISA8 WinRT Device #3 All 

RTX-03B ISA8 WinRT Device #3 All 

AX-5621 ISA8 WinRT Device #3 All 

LTC1290 COM WinRT Device #3 All 
 

Multi I/O Cards 

Interface Name Bus Type Driver Model OS 

BMC PciBase50/300/1000 

(including A/D and D/A modules) 

PCI Driver and ActiveX control from the 
manufactory, PNP 

see the 
manual of 
the interface 

BMC USB AD16f 

(Digital I/O not supported) 

USB Driver and ActiveX control from the 
manufactory, PNP 

see the 
manual of 
the interface 
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Setup the Grabber interface 

 
After installing the video capture card into the Windows system, you must tell the EE 2000 program, which of the 
installed capture cards it should use. Click on the command Grabber in the Setup menu. 

Select your video capture card and press OK. 

Setup the Digital I/O interface 
After installing the digital I/O interface into the Windows system, you must tell the EE 2000 program, which of the 
installed I/O cards it should use. Click on the command Digital I/O in the Setup menu. 

 
Select your digital I/O card and press Accept or OK. 

The Test button will open a new dialog box which shows you the status of the digital input/output lines. 

 
Port A and Port B are programmed for output, Port C is programmed for input.  
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Setup the D/A-converter interface 

 
Choose the command D/A-converter in the menu Setup. 

Select the D/A-converter interface. For more details about the selected D/A-converter interface press the Info button. 

A digital I/O interface must be installed, if you use the external D/A-converter ISODAC10. 

The number of available ranges depends on the interface model. Normally you have to select the range by setting of 
jumpers and/or dip switches on the interface. Some interfaces have the second D/A-converter channel as an option only. 

Hint: The enumeration of the D/A-channels starts with 1, independent from the selected interface model. Some 
manufactories use a 0 as the first D/A-channel. Keep this in mind, if you check the pin assignment of the connector. The 
Info text within the program gives you a correct pin assignment which is compatible with the enumeration within this 
program. 

Calibration of the D/A-converter 
External power supplies can be controlled with an analogues voltage signal of the D/A-converter. Because you set the 
electron energy in this program directly in units of eV, you have to calibrate the D/A-converter to produce the correct 
voltage when setting the electron energy. 
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Calibration can be done for the RHEED/LEED and Auger mode separately with one of the command buttons Calibration 
from the setup window. 

Typically a RHEED/LEED power supply can generate electron energies up to 1000 eV. Therefore they need normally a 
driving voltage of about 10 V.  

The calibration is done with a two point adjustment, by calibrating at a low energy and at a higher energy.  

 
! WARNING ! 

 
Be careful when handling with high voltages. 

 
1. Select Option Low. Enter a low voltage, for example 0.5 V and click on the Refresh button. 

2. Enter the correct energy value which is produced by the low voltage of the D/A-converter. Simply read the energy 
value displayed on your power supply or measure the high voltage produced by the power supply. 

3. Select option High. Enter a high voltage, for example 8 V and click on the Refresh button. 

4. Enter the correct energy value which is produced by the low voltage of the D/A-converter. Simply read the energy 
value displayed on your power supply or measure the high voltage produced by the power supply. 

5. Click again on the Refresh button to update the calibration formula 

 

Typical values for Offset are about 0 and for Gain about 0.01 (10 V = 1000 eV). 
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Setup the A/D-converter interface 

 
Choose the command A/D-converter in the menu Setup. 

Select the A/D-converter interface. For more details about the selected A/D-converter interface press the Info button. 

Hint: The enumeration of the D/A-channels starts with 1, independent from the selected interface model. Some 
manufactories use a 0 as the first D/A-channel. Keep this in mind, if you check the pin assignment of the connector. The 
Info text within the program gives you a correct pin assignment which is compatible with the enumeration within this 
program. 

Many interfaces have A/D and D/A-converter integrated. Normally you select the same interface model for A/D and D/A 
conversion. An exception is the use of external D/A-converters like the ISODAC10 model. 

During setup you see the values of the first eight A/D-channels of the interface. Changes of interface model, port 
address and range are taken into consideration after pressing the Accept button. The Accept button is disabled, if the 
current selection matches the current hardware setting. 

To reduce noise, the program can calculate the average value of multiple readings. Valid values for Samples per 
Reading are between 1 (default) and 1000. Keep in mind, that higher values will take considerable conversion time. 

In the example shown in the above window, A/D-channel 2 is shorted to ground and A/D-channel 3 is connected to D/A-
channel 1 of the same interface. The D/A-converter was set to nominal 5 V (= 500 eV not calibrated). All other A/D-
channels are open. Because of the high impedance, open A/D-channels can sense voltages much greater than 0 V. You 
can avoid this affect by connecting a resistor of 10 to 100 kOhms parallel to every A/D-channel. 

Be careful when connecting voltages to the A/D-channels. Consult the manual of the manufactory for more details. 
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Calibration of the A/D-converter 
For accurate measurements it is necessary to calibrate the A/D-converter very carefully. Press the Calibration button 
from the setup window. 

Calibration procedure: 

 
1. Enter the channel number for calibration. Known test voltages are feeded to this channel. (In the shown figure this 

is A/D-channel 3.) 

Hint: The calibration is valid for all A/D-channels. 

 
2. Connect a known voltage less than 1 V to the A/D-channel defined in calibration step 1. (For example, short this 

channel to ground.) Enter the exact value of the test voltage. Use a DVM which is accurate enough. The default 
value is the non-calibrated value measured when this dialog window was opened. Press the OK button. 

 
3. Connect a known voltage higher than 3 V to the A/D-channel defined in calibration step 1. Enter the exact value of 

the test voltage. Use a DVM which is accurate enough. The default value is the not calibrated value measured 
when this dialog window was opened. Press the OK button. 

4. At the end of the calibration procedure you see this dialog window: 

 
 The program uses this calibration formula: 

VoltageGainOffsetVoltageCal ⋅+=.  

The default values are Offset = 0 and Gain = 1. 

We recommend increasing temporary the Samples Per Reading value to 10 for best results. Don't forget to enter the old 
value after calibration. 
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II. Working with EE 2000 

The File Menu 

 

Open Image 
With this command you can load an image from the HDD or FDD for further analysis. Note, that this command always 
creates a new window. The Open Image command button in an image window replaces any existing image in that 
window. The following graphic file formats are supported and automatically detected by EE 2000: 

- TIFF - 8 Bit (*.TIF) 
Mini Color, Grey Scale and True Color (uncompressed) 

- Windows Bitmap Format - 8 Bit (*.BMP) 
Mini Color, Grey Scale and True Color (uncompressed) 

- ITEX - 8 Bit (*.IMG) 

- TIFF - 16 Bit (*.T16) 

- Windows Bitmap Format - 16 Bit (*.B16) 

- ITEX - 16 Bit (*.IMG) 

Images are always stored in the computer memory as 16 bit grayscale images. The internal 16 bit image will be 
converted into an 8 bit image for displaying. The program uses a look up table for conversion. 

If an image file includes a comment text, this text appears in the comment edit field of the image window. 

Save Image As 
Any image shown in the image window can be saved in various graphic file formats: 

- TIFF - 8 Bit (*.TIF) 
Mini Color, Grey Scale and True Color (uncompressed) 
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- Windows Bitmap Format - 8 Bit (*.BMP) 
Mini Color, Grey Scale and True Color (uncompressed) 

- ITEX - 8 Bit (*.IMG) 

- TIFF - 16 Bit (*.T16) 

- Windows Bitmap Format - 16 Bit (*.B16) 

- ITEX - 16 Bit (*.IMG) 

- FTS - 16 Bit (*.FTS) 

EE 2000 writes always the complete image into the image file. 

Hint: The 16bBit formats are only available, if the image has a dynamic greater than 8 bit per pixel. 

 

Print Image 
The image can be printed with the Print Image command from the File menu. First you must activate the image window. 
The Page Setup window appears: 

 
In the window there will appear a sample showing how the print will look like. 

The desired size can be created with Image Width, Image Height and Image Scale. Only one input is necessary. All 
others are given by the height/width ratio of the image. From Left and From Top give the position of image in the page. 
The printable size is dependent from the actual paper size of your standard windows printer. The unprintable margins 
are taken into consideration. 

With Print you can start printing. 

Printer Setup 
With the command button Printer Setup you can select a printer and define printer parameters specifically to the 
selected printer. The printer setup window is dependent from the printer driver. 

Worksheet 
This command starts the worksheet module. See chapter The Worksheet Module for a complete description. 

Exit 
Quit the program with this command. All parameters are saved in a configuration file. 
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The Grabber Menu 

 
The Grabber menu includes all commands to control image capturing. 

Preview 
The Preview command sets the program into preview mode. The software will permanently digitize and display images 
as fast as possible. The maximum frame rate depends strongly from the hardware (grabber interface and computer). 

Overlay 
Many, but not all video capture cards have an overlay capability. In overlay mode, the video capture card will 
permanently digitize an image and display the digitized image on the display. Because of special hardware capabilities, 
the data are directly moved to the video memory without read by the CPU. 

Grab 
The Grab command will digitize and display one image. 

Grab (Timer) 

 
With Grab (Timer) you can digitize a new image with a delay. Enter the delay time in seconds and press OK. 

Hint: If no video signal is connected to the grabber interface, the message "(No sync)" will appear in the comment text 
field. 
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Averaging 

 
To reduce image noise you can average over multiple images using the full dynamic range of 16 bit. The averaging 
factor must be a power of 2. The maximum average factor is 8192. The dynamic range increases with higher averaging 
values. The averaged image is temporary stored as an 32 bit image. After the averaging process finishes, the 32 bit 
image is converted to an 16 bit image. The dynamic range is decreased if necessary. 

Video Source 
The Video Source function will display a control window for setting some parameters of the video capture card. The 
design and functions depends on the installed video capture card, because this dialog box is part of the capture driver 
and not of the EE 2000 software. 

Video Format 
The Video Format function will display a control window for setting the size of the captured image. The design and 
functions depends on the installed video capture card, because this dialog box is part of the capture driver and not of the 
EE 2000 software. 
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The Scan Menu 

 
All functions necessary for experiments are summarized in the Scan menu. 

Line (Setup) 
With the Line (Setup) function you can get intensity profiles of a static image and can define up to eight lines for time or 
energy dependent experiments. 

 
The following dialog box appears. All intensity profiles correspond to the image window, which was active when the 
dialog box appears. 

Definition of a line 

All currently defined lines are drawn on the image. The currently selected line is plotted as a solid line. The unselected 
lines are plotted with dots. 

A line is defined by a starting point (X1, Y1) and ending point (X2, Y2). 

1. Select a register card for your line definition. 

2. Click on the desired starting point in your image and hold down the left mouse button while moving to the ending 
point. 

3. Release the mouse button. The line co-ordinates are shown in the co-ordinate text boxes.  

4. You can edit your line definition by clicking on the line. Watch the mouse cursor when moving the mouse over line. 

5. Set the Width of the line with the Width combo box. 

6. Choose a color for the line with the Color button. The program will open the standard windows dialog box for 
choosing a color. 
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7. Set the Averaging value. If the averaging value is 1, the intensity profile is plotted in a separate intensity profile 
window. The profile is automatically updated when you change one of the definition parameters (position, length, 
orientation, width) 

8. For time and energy dependent experiments you can set a Tracking mode. In the Fixed Position mode the position 
of the line remains unchanged during an experiment. (Other modes will be implemented in the future.) 

9. To avoid inadvertently changes to your line definition, you can lock the definition of a line with the Lock check 
button. 

10. Repeat step 1 to 7 for other line register cards. 

Scan 

Use the Scan button to get intensity profiles for a line with an averaging value greater than 1. This command is only 
available in the Camera Image window and not in a standard image window. 

Scan(t) 

When the Scan(t) button is pressed, the program will permanently digitize new intensity profiles from the camera image. 
The caption of the button is changed to Stop. The result of any changes to a line definition parameter is taken into 
account. For higher averaging values the reaction speed of the program decreases. You stop this Live mode with a click 
on the Stop button. 

Autoscale 

By default the width of the intensity profile window is calculated by the program, to match the length in pixel of the 
current line. If the Autoscale checkbox is off, the current profile window width remains unchanged, even if you change 
the length of the line. 

Grab 

You can digitize a new image from the camera by pressing the Grab button. This function is only available in the Camera 
Image window and not in a standard image window. 

Worksheet 

If you want to save the profile data or to analyze the data press the Worksheet button. The program will open a new data 
sheet and fill it with the data of the current intensity profile. See chapter The Worksheet Module for a description of 
available functions. 

Calibration 

For length measurements you can define a calibration factor for converting a length values expressed in image pixel into 
user defined units. A new dialog box will appear. 

 

Calibration procedure 

1. Define a line between two points of a known distance. 

2. Click on the Calibration button. 

3. Enable the calibration factor. 

4. Enter the known distance for the defined line in the User Length text field. 

5. Enter the unit of the user length in the User Unit text field. 
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If necessary specify the X/Y aspect ratio of the image. 

Click on OK. 

All length values are now shown in user units. 
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Color Scan 
Recording intensity profiles as a function of time (or energy) will 
produce a large amount of data. To simplify data handling, the 
Color Scan experiment offers a method to save and visualize 
profile data as an image. The intensity values of the image 
correspond to the profile intensity values. A horizontal scan line 
in the Color Scan image corresponds to the profile data of a 
fixed time value (or energy value). The vertical axis of the Color 
Image is the time (or energy) axis. 

Save 

You save the Color Scan experiment data by saving the Color 
Scan image with the Save Image As command in the File menu. 
We recommend using a 16 bit file format to avoid loss of 
information. 

Analysis 

To analyze the experimental data use the Line (Setup) 
command in the Scan menu.  

 

Color Scan Control 

The Color Scan Control dialog box gives you access to all 
important experiment parameters. 

Sweep 

All sweep parameters are summarized in the Sweep register 
card. 

1. Set the kind of experiment: I(t)-Experiment or I(E) dependent. 

2. I(t)-Experiment 

The parameters t.Start and t.Stop define the beginning and the end time of the time dependent experiment. The 
time scale starts with pressing the Start button. By default the parameter t.Start is zero. If you enter a non-zero 
value, recording of data will be suppressed for this duration. 

With t.Step you can slow down the experiment to decrease the number of data records and/or to acquire data in 
fixed intervals. If this value is zero, data acquisition is done as fast as possible. 

or 

I(E)-Experiment 

The parameters E.Start and E.Stop define the first and last energy value of the energy dependent experiment. 
E.Start may be greater than E.Stop to run the experiment from higher to lower energy values. 

With E.Step you define the energy increment/decrement. The sign of E.Step is ignored. 

3. The experiment will wait for a time of t.Dwell seconds between two data acquisition steps. 

Use a non-zero value in I(E)-Experiments, if your e-gun power supply does not output the required voltage fast 
enough. 

4. Select (already defined) lines for the experiment. 

Click on the register card Lines 
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The register card shows you all lines, which are defined in a previous step with the Line (Setup) function in the 
Scan menu. 

Select at least one line. 

The Enabled check box enables or disables all selected lines for the experiment. 

5. Select A/D-channels 

 
This register card is only available, if an A/D-converter interface is installed. 

All selected A/D-channels are monitored during the experiment. Their data are stored in the experiments 
worksheet. If the Graphic checkbox is on, the data are plotted in a separate plot window. The current voltages at 
the selected A/D-channels are displayed if this register card is selected. 

The Enabled check box enables or disables all selected A/D-channels for the experiment. 

6. Set Options 
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An experiment can by synchronized with other events. 

Select one of the trigger modes with the Mode combo box: 

(disabled) 

The program ignores trigger events. 

Test on Start of Sweep 

The beginning of the experiment is synchronized with a trigger event. 

Test on every Step of Sweep 

Every data acquisition is triggered. 

Select the trigger source with the Source combo box. A trigger event can be the status of the EXT. TRIGGER I/O 
line or a manual press of a key. 

The current level of the EXT. TRIGGER line is shown in a status field. 

External trigger requires a digital I/O interface. 

Auto Save 

All experiment data are stored in the computers memory. If the Auto Save check box is on, the data are 
automatically saved when the experiment is stopped. The program uses the default filename ~Cscan the default 
filename extension. The file(s) are saved in the windows directory for temporary files. Existing files are overwritten 
without notice. 

Plot Lines on 2nd Monitor 

If the grabber interface and driver supports overlay technique, the program shows the actual position of the 
analyzed line(s) on a second video monitor. This will decrease the maximum data acquisition rate. 

Most of the parameters take effect after pressing the Accept button. Some parameter changes require a restart of 
the experiment.  

 

New 

The New command initializes the experiment worksheet and all associated plot windows. 

 

Start - Continue - Stop 

The Start button starts an experiment. Data are stored in the worksheet from Row 1. The caption of the button changes 
to Stop. 
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Pressing the Stop button - click with the mouse or pressing the Esc key (window must have the focus)- will stop the 
experiment. The experiment worksheet is updated. The caption of the button changes to Continue. 

You can continue an interrupted experiment with the Continue button. The caption of the button changes to Stop. 

Most of the controls are disabled during a running experiment.  

A running experiment is indicated in the title bar of the program. 

 

The program distinguishes two different experiment modes: 

Normal Mode: The monitor function in the Grab menu is disabled and the Soft VTR control window is closed. 

VTR Mode: The Soft VTR control window is opened and a video file is loaded. Instead of grabbing a new image from the 
camera, the program will read the next frame of the video file. With this powerful tool you can reproduce experiments. 
Using the same experiment data will exactly result in the same data values. There is no need to use a hardware VTR 
(VTR = Video Tape Recorder). 

 

Hint: All experiment data are stored only in the computers memory. You have to save your data on hard disk drive with 
the Save command within the experiment worksheet window and with the Save Image command within the Color Scan 
window. 

Window (Setup) 
With the Window (Setup) function you can get intensity information of a static image and can define up to eight windows 
(rectangular regions) for time or energy dependent experiments. 

 
The following dialog box appears. All definitions correspond to that image window, which was active when the dialog box 
appears. 

Definition of a window 

All currently defined windows are drawn on the image. The currently selected window is plotted with a solid borderline. 
The unselected windows are plotted with dots. 

A window is defined by a starting point (L, T) - left and top position - and the size (W, H) - width and height -. 

1. Select a register card for your window definition. 

2. Click on the desired starting point in your image and hold down the left mouse button while moving to the ending 
point. 

3. Release the mouse button. The window co-ordinates are shown in the co-ordinate text boxes.  

4. You can edit your window definition by clicking on the borderline or inside the window. Watch the mouse cursor 
when moving the mouse over the rectangular. 
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5. Choose a color for the window with the Color button. The program will open the standard windows dialog box for 
choosing a color. 

6. Set the Averaging value. If the averaging value is 1, the intensity information are automatically updated when you 
change one of the definition parameters (position, length, orientation, width) 

7. For time and energy dependent experiments you can set a Tracking mode: 

Mode Description 

Fixed Position The position of the window remains unchanged during an experiment. 

Stop Mode ABS The window will be centered to the pixel with the maximum intensity value, if the 
maximum intensity is greater than the Threshold value ( ThresholdI ≥max ). 
Otherwise the position remains unchanged. 

Stop Mode REL The window will be centered to the pixel with the maximum intensity value, if the 
difference between the maximum intensity value and the average value of all 
intensity values of the pixel lying on the borderline is greater than the Threshold 
value ( ThresholdII border ≥−max ). Otherwise the position remains unchanged. 

Follow Mode The window will be centered to the pixel with the maximum intensity value, if the 
difference between the maximum intensity value and the average value of all 
intensity values of the pixel lying on the borderline is greater than the Threshold 
value ( ThresholdII border ≥−max ). Otherwise the new position is extrapolated 
from the previously position and energy values. This mode requires, that an I(E) 
experiment will start with a good visible spot for the first energy values. The track 
parameters are automatically saved. 

Repeat Mode The windows centre position will always be calculated from the previously saved 
Follow Mode track parameters. In this mode, you can start the I(E) experiment with 
invisible spots. Another advantage is that the window track is a straight line. 

In Repeat Mode you have access to two additional buttons:  and . 

 clears the track parameter.  
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8. To avoid inadvertently changes to your window definition, you can lock the definition of a window with the Lock 
check button. 

9. Repeat step ∈ to ™ for other line register cards. 

Scan 

Use the Scan button to get intensity profiles for a line with an averaging value greater than 1. This command is only 
available in the Camera Image window and not in a standard image window. 

Scan(t) 

When the Scan(t) button is pressed, the program will permanently digitize new intensity profiles from the camera image. 
The caption of the button is changed to Stop. The result of any changes to a line definition parameter is taken into 
account. For higher averaging values the reaction speed of the program decreases. You stop this Live mode with a click 
on the Stop button. 

Autoscale 

By default the width of the intensity profile window is calculated by the program, to match the length in pixel of the 
current line. If the Autoscale checkbox is off, the current profile window width remains unchanged, even if you change 
the length of the line. 

Grab 

You can digitize a new image from the camera by pressing the Grab button. This function is only available in the Camera 
Image window and not in a standard image window. 

Worksheet 

If you want to save the profile data or to analyze the data press the Worksheet button. The program will open a new data 
sheet and fill it with the data of the current intensity profile. See chapter The Worksheet Module for a description of 
available functions. 
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I(t)-Experiment… / I(E)-Experiment 
With the I(t)-Experiment resp. I(E)-Experiment function an experiment is performed. All Lines and Windows defined with 
the Line (Setup)… resp. Window (Setup)… function can be selected for an experiment. The intensity profile resp. 
intensity values are recorded as a function of time resp. as a function of energy. 

The I(E)-Experiment is also known as I(V)-Experiment. 

  
The I(E)-Experiment can only selected, if a D/A-converter is installed.  

 

The Sweep Tab 

I(t)-Experiment 

t.Start: Defines the beginning of an experiment. This value works as a delay. Normally it is set to 0 s.  

t.Stop: Defines the end of the experiment. If this value is set to zero, the experiment runs infinite (until the 
user stops the experiment or an error occurred (e.g. disc full). 

t.Step: This value defines the time interval between grabbing an image. A value of 0 will define the fastest 
recording rate. Depending on the hardware and parameters, the software cannot guarantee the 
interval time defined by t.Step (especially for small values). 

I(E)-Experiment 

E.Start: Defines the first energy value of an experiment.  

E.Stop: Defines the last energy value of an experiment.  E.Stop can be less than E.Start. 

E.Step: This value defines the energy step between grabbing an image. This value is always positive. 

I(t)-Experiment / I(E)-Experiment 

User: If this check box is enabled, all .Start, .Stop, and .Step values are ignored. Instead, user defined 
time resp. energy values are used. These values are read from a sweep file. This is an Ascii file 
containing the time resp. energy values in seconds resp. in eV. The sweep filename is shown in 
textbox File. The user defined sweep values allow non-equidistant step values. Energy sweeps are 
possible in a non-monotonic order. Time values must be in an ascending order and in the range of 
0…86400 (0 s … 24 h). Energy values must be in the range of 0…3000 (eV).  
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Dwell Time: If a new time value defined by t.Step is reached, a delay defined by the Dwell Time occurs, before 

the image is grabbed. For I(E)-Experiments this is useful, if the power supply of the energy gun 
needs some time until the energy is set to the correct value. 

Cancel: A click on the Cancel button will reset the parameters to the last valid values. 

Accept: will accept all changed parameter values 

New: Resets the experiment.  

Start: Starts an experiment, beginning with t.Start resp. E.Start. 

Continue: Continues an experiment after a stop. 

Stop: This stops the experiment. 

The Windows Tab 

 
All Windows defined with the Window (Setup)… function can be selected for the experiment. In this example, window #1 
and window #4 are defined, but only window #1 is selected for the experiment. 

Record: With Record you can define whether an intensity parameter is recorded or not. (See also the 
commands to Enabled.) 

Graphic: With Graphic you can define whether an intensity parameter is plotted or not. . 



EE 2000 I - 28 

 

 

Shutter: The checkbox Shutter Enabled activates a shutter control function. If it is activated, you can select 
one of the windows used in the experiment to feed the shutter control algorithm with intensity data 
by clicking on the appropriated option box. 

Enabled: if the checkbox Enabled is checked, all windows selected with the Record checkbox will be used in 
the experiment. If it is disabled, all entries on this tab are ignored.  

Y Plot Range Locked: All plotted intensity values are shown in a separate plot window. The Y-axis is automatically 
set to the correct range. If the user changes Y-scale, these changes will be used as a default 
scaling, when this checkbox is checked. 

Move… With this command you can move the window position for the next scan step(s). 

 
 -  Select the Window you want to move 

 -  The check box Fast defines the movement step: 1 pixel of 8 pixel 

 -  Use the Movement buttons to move the selected window: the current position is used for the 
next scan step. 

 -  With the check box Set as start position marked, the current position is used for the Start of 
the scan. 

Setup… This calls the Window (Setup)… dialog box. The experiment dialog box will be closed. 

The Lines Tab 

 
All Lines defined with the Line (Setup)… function can be selected for the experiment. The intensity profiles of all selected 
lines will be plotted during the experiment. Note: the profile data are NOT recorded. Use the Color Scan… function in the 
Scan menu for recording intensity profiles. 
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The Options Tab 

 
On the Options Tab you can define the trigger parameters and how to handle the online data.  

Trigger 

Mode: Select one of the trigger modes: 

  
Source: Select the trigger source: 

  
 If a digital I/O card is installed, the digital input line EXT. TRIGGER can be used as a trigger source. 

The software can react on static signals (low or high) or on signal changes (low to high or high to 
low). The current signal of the EXT. TRIGGER line is shown in the Status EXT. TRIGGER field. 

 With Manual Control the software asks the user for a manual trigger input. 

 DDE Trigger and File Trigger are special trigger sources. Asks the programmer for more details. 

Worksheet: The parameters collected during an experiment are displayed in a worksheet.  

 Auto Save: If checked, the worksheet is automatically saved at the end of an experiment. The 
filename is automatically generated by the software. 

 Save X.max, Y.max: If checked, the coordinates of the pixel with the highest intensity value is 
also written to the worksheet. 

 Update If checked, the collected experiment data are immediately displayed in the 
worksheet. If unchecked, the maximum acquisition rate can be realized. The data 
are displayed to the worksheet when the experiment is stopped. 

 Online Export: The worksheet data can be exported to a Microsoft Excel sheet during an 
experiment, if this checkbox is checked. The name of the Excel sheet is defined in 
the Excel field. 
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Image Recorder… 
A sequence of images can be recorded to the hard drive and can be used later as the image source for experiments. 
The sequence can be a function of time or energy. 

The Sweep Tab 

  
Most of the parameters are equal to the parameters described in the I(t)-Experiment… resp. I(E)-Experiment… function 
in the Scan menu. 

Filename: Enter the complete filename (including path and extension) of the video file. 

 Use the  button. 

Averaging: Before recording to the file, a sequence of images can be averaged. This will decrease the noise in 
the images but slow down the experiment. 

The A/D Channel Tab 

The A/D Channel Tab is described in the I(t)-Experiment. 
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The Options Tab 

 
Trigger The Trigger options are as described in the I(t)-Experiment. 

Worksheet The experiment data (time, energy, A/D-channels) are saved to a worksheet. 

 Auto Save: If checked, the worksheet data are automatically saved to the file ~Sweep.sht in the 
directory of temporary files of the current user when the experiment is stopped.  

Film: The film data are saved to the hard drive. The operating system uses a file buffer to speed up writing 
to the hard drive. If the buffer is full, the data are written to the hard drive.  

 Flush File Buffer: If checked, the file buffer is written to the hard drive after every image. This 
is recommended for experiments with many images and if the image rate should be 
as constant as possible. 

The Video Source Tab 

 
If the grabber interfaces driver supports multiple video inputs or if more than one single digital camera is connected, you 
can define in which sequence the inputs/cameras should be used for the experiment. The input/camera is changed after 
every step of the experiment. A file for each input/camera is generated. 
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The Auger… Menu 

The Auger experiment can be performed with this function. 

A 2nd D/A channel is used to control the mesh energy during the Auger experiment.  

 

The File Menu 

 
New Ramp Creates a new (empty) energy ramp 

Load Ramp… Load and opens a file containing ramp data 

Save Ramp Saves the current energy ramp using the existing filename 

Save Ramp as… Saves the current energy ramp using a new filename 

Close Closes the Auger Control window. 
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The Sweep Menu 

 
Add Sweep Adds a new sweep before or behind the marked sweep depending on the energy values: if the E.to 

value of the previous sweep is equal then the E.from value of the marked sweep, the new sweep is 
added behind the marked sweep. 

Remove Sweep Removes the selected sweep from the list. 

Edit Sweep Editing of the sweep parameters 

 
 Each sweep is defined by an energy range (E.from and E.to) and the energy step value (E.step). 

E.from can be less then E.to. E.step is always a positive value. For each sweep you can define 3 
integration time values (Int.Time) for the 3 Profile modes (Fast, Regular, and Exact).  

 

The Energy Ramp Tab 
The Energy Ramp tab shows all parameters defining the energy ramp. In this example, the experiment the energy ramp 
has 3 energy sweeps. An experiment can be repeated depending on the value of Iterations. 

The Auger experiment is explained in the following simplified flow diagrams:  
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ACQUISITION: 

 E[DataIndex] = MeshEnergy 

 U[DataIndex] = Intgerate AugerVoltage, Int.Time[SweepIndex] 

 Derivative ? 

  YES: DataIndex > 0 ? 

    YES: E2 = E[DataIndex] : E1 = E[DataIndex - 1] 

     U2 = U[DataIndex] : U1 = U[DataIndex - 1] 

     E1 <> E2 ? 

      YES: AES_Energy = (E1 + E2) / 2 

       AES_Signal = (U2 – U1) ( E2 – E1) 

       UpdateWorksheet… 

  NO: AES_Energy = E[DataIndex] 

   AES_Signal = U[DataIndex] 

   UpdateWorksheet… 

 DataIndex = DataIndex + 1 

Return 

START: 

 IterationIndex = 0 

FIRST_SWEEP: 

 SweepIndex = 0 : DataIndex = 0 : MeshEnergy = E.from[SweepIndex] 

CONTINUE: 

SetMeshEnergy(MeshEnergy) 

Wait(Delay) 

ACQUISITION // see flow diagram below 

MeshEnergy = MeshEnergy + E.step[SweepIndex] 

MeshEnergy > E.to[SweepIndex] ? 

 YES: SweepIndex = SweepIndex +1 

  SweepIndex >= NumberOfSweeps ? 

   YES: IterationIndex = IterationIndex +1 

    IterationIndex >= Iterations ? 

     YES: Goto END 

     NO: Goto FIRST_SWEEP 

   NO: MeshEnergy = E.from[SweepIndex] 

Goto CONTINUE 

END: 
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The Options Tab 

 
Worksheet 

Auto Save The worksheet is automatically saved at the end of the experiment in the default path for 
worksheets. The Filename is generated by the software: AES_<date>_<time>.sht. 

Update If checked, the worksheet is updated during the experiment. Otherwise the worksheet is updated 
only if the experiment is stopped. 

Plot 

Reverse Energy Scaling If checked, the energy scale in the plot is reversed, going from higher energy values to lower 
energy values. 

Experiment Control 

 
New The experiment is reset. 

Start The experiment starts with the 1st sweep of the 1st iteration. 

Continue The experiment continues at that point, where it was stopped before. 

Stop Will stop the experiment. 

Iterations The energy ramp can be repeated by the number of Iterations. 

Close This command closes the Auger control window. 
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The Image Menu 

 
All image editing functions are summarized in the Image menu of the main window. 

Single Image Processing 
You can modify image data with the Single Image Processing command. A new dialog box appears. 

1. Select the image 

Use the drop down box labeled "Source Image" to select the image that you want to modify.  

2. Enter the constant value const. 

const may be any long integer value. 

3. Select the Function 

Click on a function in the Function Group Box. Function processing is performed as follows:  

- A copy of the source image is made. The original image is used for the Undo function. 
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- The intensity data from the source image is combined with the const value according to the formulas detailed 
below.  

Function New Color Value Equals 

Add Source Image Value + Const 

Multiply Source Image Value * Const 

Subtract Source Image Value – Const 

Darkest Minimum of (Source Image Value, Const) 

Difference Absolute Value of (Source Image Value - Const) 

Lightest Maximum of (Source Image Value, Const) 

AND Source Image Value & Const 

OR Source Image Value | Const 

Exclusive OR Source Image Value ^ Const 

Divide Source Image Value / Const 
 

4. Set the Modifiers 

The modifiers are applied to the intensity values produced by the function formula.  

Divisor 

The intensity value produced by the function formula is divided by the value selected in the Divisor text field. This 
allows you to reduce the effects of the other selections.  

Bias 

You use the bias to shift each intensity value by a fixed amount. The value selected in the Bias text field is added 
to the intensity value produced by the function formula and divisor selections.  

Clip Intensity Values 

The Clip Intensity Values checkbox determines how the program handles final intensity values that are greater 
than the maximum valid intensity value (dependent of the dynamic range) or less than zero.  

Setting X < 0 X > MAX 

On X = 0 X = MAX 

Off X = X MOD (MAX + 1) X = X MOD (MAX + 1) 
 

5. Select the OK button 

Click on the OK button. The program will close the dialog box and modifies the source image. 

Image Arithmetic 
The Image Arithmetic function combines data from two images. The function accepts any two images as input, and 
produces a third image (or changes source image #1) that is the product of the source images' intensity data.  

1. Open the images 

The Image Arithmetic function is only available if at least two images are visible. Use the Open Image command 
from the File menu to load an image into a new image window. 

2. Select Image Arithmetic from the Edit menu 

The program will open the Image Arithmetic dialog box. 
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3. Select the images 

Use the drop down boxes labeled Source 
Image #1 and Source Image #2 to select 
the images that you want to combine. The 
size and dynamic of the resulting image is 
determined by source image #1.  

4. Select the function 

Click on a function in the Function group 
box. Function processing is performed as 
follows:  

- A copy of source image #2 is resized to 
match source image #1. The resized copy 
is used in the function processing. It 
resides in temporary memory and is not 
displayed.  

- The dynamic of the copied image is 
changed to match the dynamic range of 
source image #1. 

- The intensity data from the two images 
is combined on a pixel-by-pixel basis 
according to the formulas detailed below.  

 

Function New Color Value Equals 

Add Image 1 Value + Image 2 Value 

Multiply Image 1 Value x Image 2 Value 

Darkest Minimum of (Image 1 Value, Image 2 Value) 

Subtract Image 1 Value - Image 2 Value 

Difference Value of (Image 1 Value - Image 2 Value) 

Lightest Maximum of (Image 1 Value, Image 2 Value) 

AND Image 1 Value & Image 2 Value 

OR Image 1 Value | Image 2 Value 

Exclusive OR Image 1 Value ^ Image 2 Value 

Fade X * Image 1 Value + (1 - X) * Image 2 Value, X = 0 ... 1 
 

5. Set the modifiers 

The modifiers are applied to the intensity values produced by the function formula.  

Divisor 

The intensity value produced by the function formula is divided by the value selected in the Divisor text edit field. 
This allows you to reduce the effects of the other selections.  

Bias 

You use the Bias to shift each intensity value by a fixed amount. The value selected in the Bias text edit field is 
added to the intensity value produced by the function formula and divisor selections.  

Clip Color Values 

The Clip Color Values checkbox determines how the program handles final intensity values that are greater than 
the maximum valid intensity value or less than 0.  
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Setting X < 0 X > MAX 

On X = 0 X = MAX 

Off X = X MOD (MAX + 1) X = X MOD (MAX + 1) 
 

6. Select the OK Button 

Click on the OK button. The program will close the dialog box and calculate the new image from the combined 
intensity data.  

Resize 

 
You can select one of up to five standard image sizes, a custom size by width and height, or a custom size by aspect 
ratio.  

Standard Sizes 

The five standard image sizes are listed in the group box on the left. To select one of the standard sizes, click on the 
option's button or its text. Standard image sizes are equivalent to the first five available resolutions of the current frame 
grabber / digital camera. 

Custom Size by Width and Height 

To specify a custom size by width and height in pixels:  

1. Click on the Custom Size option.  

2. Empty the Maintain Aspect Ratio checkbox.  

3. Type the new width into the first text box.  

4. Press <Tab>.  

5. Type the new height into the second text box.  

Custom Size by Aspect Ratio 

The aspect ratio is the relationship between the image's two dimensions, expressed as width divided by height. To 
specify a custom size using the aspect ratio:  

1. Click on the Custom Size option.  

2. Mark the Maintain Aspect Ratio checkbox.  

3. The Aspect Ratio text box will display the image's current aspect ratio. If you want to change the ratio, click in the 
text box, and then type the new ratio.  

4. Enter the setting for the dimension that you want to fix. For example, if you want to fix the width and let the height 
be determined by the aspect ratio, click in the Width text box and type the new width. The remaining field will 
update when you either (a) exit the current field, or (b) select the OK Button.  
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Negative Image 
The Negative Image function replaces each intensity with its opposite. The effect is similar to a photographic negative.  

VGA Display LUT 
All images are stored in memory with a maximum of 16 bit dynamic range. Before an image is 
displayed on the VGA screen, it is converted into an image with 8 bit resolution by using a 
LUT (= Look Up Table). With this function you can dramatically increase the contrast of an 
image. 

In the Display group you can select one of five basic LUTs: 

- Grayscale LUT 

This is the default palette. 

- Rainbow LUT 

The rainbow LUT produces a false colors image. 

- Green LUT 

This LUT displays the image similar to an image on a green phosphor screen. 

- Orange LUT 

This LUT displays the image similar to an image on an orange phosphor screen. 

- Yellow LUT 

This LUT displays the image similar to an image on a yellow phosphor screen. 

The Inverse checkbox inverts the intensity values. 

All settings will only affect the displayed (8 bit) image. The internal 16 bit image data remain 
unchanged. 

The LUT dialog box corresponds only to that image window, which was active when the 
dialog box was opened. The LUT for other image windows remain unchanged. 

Hint: On VGA display with 256 colors, changing the LUT of one image window will change 
the appearance of other image windows. Windows also gives only 236 palette entries to the 
user (Windows itself uses 20 reserved colors), which can produce some pixel with wrong 
colors. 

We recommend using 32 bit true color display mode to achieve best results. 

 

Change Dynamic 
You can simply change the dynamic of the active image window with the Change Dynamic command. A second menu 
will appear where you can select one of nine different dynamic ranges. The current dynamic is marked. 
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Histogram 
The Histogram function gives you an overview about the 
distribution of intensity values in the active image window. The 
X-axis is the intensity axis scaled from intensity value 0 to the 
maximum possible intensity value. The maximum possible 
intensity value is equal to the dynamic range minus 1. 

The histogram window shows also the minimum and maximum 
intensity value of the image. 

A blue and red line mark the lower and upper limit of the LUT, if 
the LUT dialog box is simultaneously opened. 

Filter 
You can create and apply your own filters.  

How Filters Work 

A filter alters each pixel's intensity based on its current intensity and the intensities of any neighboring pixels. The heart 
of a filter is an array of coefficients called a filter matrix.  

A filter processes an image pixel-by-pixel: each pixel's intensity value is multiplied by the coefficient in the matrix centre, 
and any pixels within the matrix are multiplied by the corresponding coefficients.  

The sum of the products becomes the target pixel's new value. The new value is saved in a separate bitmap so that it 
does not affect the remaining pixels.  

The formula for this calculation is: 
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Where F is the filtered value of the target pixel, P is a pixel in the grid, and C is a coefficient in the matrix.  

 

Applying a filter 

1 Select Filter from the Edit menu. The program will open the Filter dialog 
box.  

2 Click on the filter in the Filter Name list box.  

3 Click on the Apply button. The program will close the dialog box and 
apply the filter.  

 

Creating a user defined filter 

1. Open the Define New Filter Dialog Box 

2. Select Filter from the Edit menu. The program will open the Filter dialog box.  

3. Click on the New button. The program will open the Edit Filter dialog box.  

4. Enter the Filter Name 

Type the new filter's name into the Filter Name text box.  

5. Enter the Filter Matrix values 

Enter the filter matrix values into the table in the centre of the dialog box. Non-integers will be truncated. See the next 
step for help achieving the same effect as decimal coefficients.  
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6. Set the Division Factor 

You can think of the division factor as the coefficient denominator: each coefficient in the filter matrix is divided by 
the division factor before being applied to a pixel. In actuality, the division factor is applied to the product of the 
matrix calculation. The division factor changes the filter formula to:  
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Where F is the filtered value of the target pixel, P is a pixel in the grid, C is a coefficient in the matrix, and D is the 
division factor.  

The division factor allows you to achieve effects that would otherwise require decimal coefficients. The advantage 
of requiring non-decimal coefficients is execution speed: the program can accelerate the filtering process by 
perform the math using integers.  

Using the Division Factor 

- Raise the decimal coefficients to integers by multiplying them by the division factor (typically 10, 100, or 1000).  

- Enter the "integer-ized" coefficients in the matrix.  

- Enter the division factor in the Division Factor text box. Non-integers will be truncated.  

7. Set the Bias 

The Bias is added to the product of the matrix calculation and the division factor. You use the bias to shift the 
value of each pixel by a fixed amount. Bias adjustments are particularly useful for creating embossing effects. The 
bias changes the filter formula to:  
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Where F is the filtered value of the target pixel, P is a pixel in the grid, C is a coefficient in the matrix, D is the 
division factor, and B is the bias.  

Using the Bias 

Non-integers will be truncated.  

Integers outside of the range of 0 to the maximum valid intensity value will be clipped to fall within the range. 

8. Select the OK Button 
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When you've finished entering the filter's settings, click on the OK button. The program will save the filter and return to 
the Filter dialog box. To apply your new filter to the active image:  

- Click on it on the Filter Name list box.  

- Click on the Apply button. The program will close the dialog box and apply the filter.  

Flip, Mirror 
The Flip and Mirror commands reverse an image orientation along the vertical and horizontal axes:  

Flip command 

The Flip command reverses the image vertically, so that what was the top becomes the bottom, and vice-versa. To use 
the command, select Flip from the Edit menu.  

Mirror command 

The Mirror command reverses the image horizontally, so that what was the left side becomes the right side, and 
vice-versa. To use the command, select Mirror from the Edit menu.  

Rotate 
The Rotate command rotates an image 90 degree to the left or to the right. 

Interlacing 
Normal video cameras digitize an image which consists of two interlacing pictures containing the 
odd and the even lines of the whole image. The complete image with all lines is called a frame. The 
two interlacing pictures with only the odd or even lines are called a filed. The first field contains the odd lines (1, 3, 5,...) 
where the second field contains the even lines (2, 4, 6, ...). The time between capturing both fields is 20 ms (50 Hz) or 
16.7 ms (60 Hz) depending on the video system. A rapidly changing image will produce interlacing effects in the frame. 
With the Interlacing function you can extract a field from the frame. The aspect ratio will be maintained by drawing every 
line twice. 

Measure of Length 

 
The Measure of Length function gives you the capability to measure distances and angles in an image. There are three 
options how to measure lengths: 

Line 
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Click with the moue on the image where the line should start. Hold down the mouse button and move the mouse pointer 
to the end point of the line and release the mouse button. 

Polygon 

Define every polygon point by clicking with the mouse at the required position in the image. The point co-ordinates are 
accepted, when the mouse button is released. You can delete the last point definition with the Delete command. You 
can un-delete a point by clicking on the Un-Delete button. 

Freehand 

Click at the starting point of a freehand curve. Hold down the mouse button and move the mouse pointer. The length of 
the mouse movement will be measured. You can also delete and un-delete the curve definition points. 

The Reset command clears all curve definitions and set the length to zero. The measured length will be in the units 
defined with the Calibration command in the Line (Setup) dialog window. 

The angle of the last defined curve segment is also displayed. The direction starts with 0° at a line from the left to the 
right and increases counter clockwise. 
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III. The Worksheet Module 

The worksheet module starts with an empty sheet (worksheet) on the screen. Pay attention to the alteration of the menu 
line. 

 
 

 
 

All experiment data are stored in a worksheet file format compatible to the DOS programs eeScan, eeScan-RL, AIDA-
PC and bioScan.  

With EE 2000 this file format includes additional information for plot parameters. The DOS programs will ignore these 
data. 

A worksheet consists of at least 3 columns and 2 rows (including the fixed header row, and the fixed row column).  

The column headers show the name of a column - by default a new column gets an unique letter -, the type of data for 
calculations and plots (X or Y interpreted data), and an optional column label. A column is always referenced by the 
column name (because he is guaranteed to be unique). A legend of a plot will show the column label if it is defined, else 
the column name is shown. 

The row number appears on the left side. 
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The Worksheet File Menu 

 

New 
Use the New Command to create a new empty  

Open 
With Open you can load a previously save worksheet. 

Save, Save As 
The command Save will save the worksheet with the same filename as the worksheet was opened. If no filename is 
defined, a file selection window will appear. 

Use Save As to save the worksheet into a new file. 

Import 
You can import ASCII data files into an existing worksheet with Import | ASCII in the File menu. The default filename 
extension is *.DAT. How the ASCII data are imported is depended from the import option settings. Import | Options will 
show this window: 
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File Structure 

A carriage return (0x0D) and/or line feed (0x0A) separates different rows. Columns can delimit by a special character or 
they have a fixed column width. 

Most windows programs use a tab character (0x09) as a delimiter. Some FORTRAN programs often export the data with 
a fixed column width. 

File Header 

ASCII files can include non numeric header lines. EE 2000 can automatically detect these header lines or you can 
directly specify the number of header lines. The header lines are not saved in the worksheet. 

# of Columns 

All columns are loaded from the ASCII file if the option button Unknown is selected. However, you can define that only 
subsets of columns are imported. Enter the number of columns to import in the edit field. If this value is greater than the 
number of columns in the ASCII file, he will be ignored. 

Import into worksheet as 

With this combo box you can define, how the ASCII data are imported: 

1. New Data Before the data are imported, a new worksheet is created.  

2. New Columns The data are merged to the existing worksheet by adding new columns to the right of last 
column. The number of rows will be increased if necessary. 

3. New Rows The data are appended to the existing worksheet after the last row. The number of columns 
will be increased if necessary. 
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The decimal 'point' character depends from your windows language settings. In Germany the decimal point is 
represented by a comma: the value one thousand and a half is written as 1000,5 (or 1.000,5). 

You can define the decimal point character by calling the Systemsteuerung and then clicking on the icon Datums-, Zeit-, 
Sprach- und Regionaleinstellungen. 

 
 

In the new dialog box click on  

 

 
Select register card Regionale Einstellungen and click on Anpassen.  

Define your decimal point in the combo box Dezimaltrennzeichen. Check, that your decimal point is unique. 
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Export ASCII 
The Export function save the worksheet in ASCII-format, so that other programs can access the data. The program uses 
a tabulator for separate data. Each data record ends with a carriage return + line feed sequence. The decimal 'point' 
character depends from your windows language settings.  

Print 

 
You can print the complete worksheet or only a part on a printer with the Print command in the File menu. 

Printer Setup 
Use this command to select a printer or to change printer parameters. 

Close 
With the Close command you exit the worksheet module. All plot windows based on the worksheet are closed. A 
warning appears, if changes to the worksheet are not saved. 
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The Worksheet Edit Menu 

 
The commands Cut, Copy, Paste and Clear are normal clipboard functions and apply to the selected region of the 
worksheet.. 

Clear Worksheet will clear all data in the worksheet. The dimensions of the worksheet and the columns properties 
remain unchanged. 

Use the Insert and Delete command to insert resp. delete columns or rows of the worksheet.  

The Go To Column and Go To Row commands are useful to navigate in a large worksheet. Both commands accept the 
keyword last instead of a column name resp. row number to move to the last column resp. row. 

The Worksheet Plot Menu 

 
 

To create a new plot window use one of the commands in the Plot menu. 

The Line command will create a line plot: all data points are connected with a solid line. With the Scatter command all 
data points are plotted as a symbol. To draw a symbol at every data point and connect all data point with a solid line use 
the Line + Symbol command. If you have not selected any column, the following window appears; otherwise the selected 
data are plotted immediately. 
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Select any column as X-data and at least one column as Y-data. Enter a title for the plot and axis labels if you want. The 
data can also be changed later. 

 

Press the OK button to plot the data. 

 
 

You can create multiple plot windows. Pay attention to the changes in the menu line if you make a plot window the active 
window. See chapter Plot Module for more details. 
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The Worksheet Column Menu 

 
 

Set as X, Set as Y, Set as Label 
Define the column type with the Set as X, Set as Y or Set as Label command. Some functions need X-data for 
calculation. The nearest X-column left to a specified Y-column is used as a source for X-data. 

Hint: The Row column is always of type X. 

Add New Columns 
To add new columns to the worksheet use command Add New Columns and enter the number of columns to be added. 

Width Of Columns 
The width of columns in the window can be changed width the Width Of Columns command. Enter the new width in units 
of characters. A width of 13 characters will guarantee that the complete number is displayed.  

Move To First, Move To Last 
To move the leftmost selected column before the first column use the Move To First command. Move To Last moves the 
leftmost selected column behind the last column. 

Rename Column 
You can edit some column parameter as the column name with the Rename command. The Rename Column dialog 
window appears. 

Column name 

The column name must be unique in the worksheet. Mark the checkbox Enumerate all columns to the right to append a 
number to existing column names beginning with the currently selected column. 
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Column Label 

Enter any text to this edit field. This text will appear in the column header line and in the legend of a plot. 

Write Protection 

Use this checkbox to guarantee, that the column data remain unchanged during a worksheet session. Worksheet 
columns crated by any experiment are write protected by default. Normally you should not disable write protection for 
original experiment data. 

The Worksheet Data Menu 

 

Set Worksheet X 
If your worksheet does not include a X-column, the program will use the row number as X-data. In some cases you may 
want to generate your own X-column. Use command Set Worksheet X to generate a new X-column. 

 
A new column is created but not visible. The value in row 1 of this column contains the Initial X value. All following 
values are incremented by the Increment in X value with every row. The formula is: 

( ) ( ) incinit XrowXrowX 1−+=  

Show X Data 
With the command Show X Data in the Data menu the new created X-column will be displayed. 

Sort 

 
All column data can be sorted in ascending or descending order with the Sort command. 
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The Worksheet Math Menu 

 
Many analysis functions are implemented in the worksheet module. Some of them are only available if exactly 1 column 
is selected. 

Simple Math 

 
Basic operations can be performed with this function. A new window appears. 

The basic operation is: 

 

Y an existing column where the result of the operation is written to. If you want to write the result of the operation into 
a new column, please first insert a new column with the Insert Column command in the Edit menu. A new column is 
inserted directly left to the currently selected columns. 

Y1 an existing column or a numeric value. 

 

Operator basic operation 

+ Add 

- Subtract 

X Multiply 

/ Divide 

^ Powered by 
If Operator is empty, the Y2 parameter will be ignored.  

Y2: an existing column or a numeric value. 
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Functions 

 
Some functions can be directly applied to a selected column. These functions are available: 

LN(X) natural logarithm, base e 

e^X exponential function, base e 

LOG(X) decade logarithm, base 10 

10^X 10 powered by X 

Sqr(X) square root of X 

X^2 quadrate function 

X^3 cube function 

1/X reciprocal function 

ABS(X) absolute function 

SGN(X) sign function 

255 - X inverse intensity data 

FFT 

 
This command performs a fast Fourier transformation of the selected column. If the number N of data values cannot be 
represented by  

,...5,4,3,2,2 == iN i  

additional data values are calculated by interpolating. The data of the X-column are interpreted as time values. The 
imaginary part is assumed to be zero. The result of the FFT is written into two new created columns containing the 
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frequency and amplitude values. These two columns are added behind the last column, because the frequency column 
is a new X-column and should not affect existing Y-columns. 

Differentiate, Integrate 
These commands will differentiate resp. integrate the selected column. 

Smoothing 
To smooth data values use the Smoothing command. You can enter the degree of smoothing. The program uses 
following formula: 

( ) ( ) ( ) ( )
4

121 +++−
=

iYiYiYiYnew  

The first and the last Y value remain unchanged. This calculation will be repeated corresponding to the degree of 
smoothing. 

 

R-Factor 

 
You can use the Pendry-R-Factor for quantitative comparison of I(E) spectra: 

( )
( )

( ) 2,1,1,
1 2

0

2
21

2
21

=
∂
∂

=
+

=

+

−
=
∑
∑

j
E
I

I
L

LV
L

Y

YY
YY

R

j

j
j

ji

j
j

Pendry

 

L is the logarithmic derivative of intensity by energy. For very low intensity values I the logarithmic derivative can get 
unphysical singularities. To avoid this, you can define a threshold value as a percentage of the maximum intensity value. 
All intensity values below the threshold will be ignored for the calculation of RPendry.  

Out of experience of LEED-experiments it is known that the electron suppression limited the steepness of intensity 
variation by energy. For that intensity peaks can have minimal energy width of 2 * V0i and obtains a maximum gradient of 
IPeak/V0i (V0i = imaginary part of the inner potential). Unphysical values for the logarithmic derivative L are limited with the 
Y-function and 'normal' values are barely altered. The Pendry-R-Factor is the medium quadratic derivative between the 
Y-functions of the compared spectra. 

The value of RPendry is zero for identical spectra, 1 for two statistically independent spectra and 2 as a maximum for two 
anti correlate spectra. Two good matching I(E) spectra will result in a value of typical 0.1 to 0.3 for the Pendry-R-factor. 
With the comparison of the gradient of the spectra the Pendry-R-factor is more sensitive for peak positions than for peak 
heights. 

Another scale to compare different spectres is the R-factor: 
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This factor can be used to compare two I(t)-spectra with unknown energy. 

You can select more than one column for calculation. In the shown example the calculation will be performed for 4 
columns. EE 2000 automatically looks for a column label Energy. If a column with this label is found, it becomes the 
energy column by default. The program also looks for columns with the label I.total... and automatically selects these 
columns. 

Of course you can overwrite the default settings. The default values are: Voi = 4 eV and threshold = 1%. 

The result of the calculation is written into a new text edit window. 

 

Peak Fit 
With EE 2000 you can simply fit a combination from multiple Gauss and Lorenzian peaks to any column data. 

( ) ( )∑
=

++=
n

i
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0  

n 0 number of peaks (n = 0, 1, 2, 3,...). Fi(x) is one of the following peak functions: 
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The coefficients are (the program uses the notation shown in brackets): 

xc = peak position [xc1, xc2, ...] 

h = height of peak [h1, h2, ...] 

w = width of peak [w1, w2, ...] 

y0 = offset  [y0] 

m = slope  [m] 

 

Executing a peak fit 

Select a column to fit and choose command Peak Fit from the Math menu. 
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A new column will be automatically created to hold the estimated value of the fit. Also a new plot window will appear 
which shows the original data (black line + symbols) and the estimated values (red line). At least a fit control dialog 
window appears. In the fit control box you can define and edit fit parameters and start the fit. 

If you call the fit module the first time, all fit coefficients are zero (offset, slope, number of peaks). 

To start the fit, you must first define the initial coefficient values. This can be done with the Auto Input command button in 
the fit control box. 

 
In this example the software detects two peaks. The shape and width of the peaks are predefined with the Fit Setup 
command. 

The list field shows all fit coefficients. Every entry in the list starts with the symbolic name of the coefficient followed by 

the initial coefficient value. The parameter A behind the peak type shows the area under this single peak: 
2
π

iii whA =  

for Lorenzian peaks and: 
2
π

iii whA =  for Gaussian peaks. 

You can edit all coefficient data of a selected list entry in the first line in the fit control window. We distinguish three types 
of coefficients: 

1. independent coefficient 
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The value in the Input edit field is the initial value for the fit algorithm. The combo box FF (FF = Fit Flag) shows = 
?. 

2. constant 

The fit algorithm will use the value of the Input edit field. This value remains unchanged during the fit procedure. 
The combo box FF shows = const. 

3. dependent coefficient 

The value of this coefficient will be set to the value of a different fit coefficient after each iteration step. The link 
must be done to a fit coefficient of the same type and must have a lower index. The combo box FF shows the 
name of the linked coefficient. 

Auto Input 

This function detects the number of peaks and calculates the initial fit coefficient values. The Auto Input routine uses 
following procedures: 

- original data are filtered with a despecle filter (spikes are removed) 

- smoothing the data by averaging over five points 

- searching for minima and maxima. Data points less than the MinIntensity value (see Filter Setup) are ignored. A 
maximum is detected, if the difference between a local maximum and the next minima is greater than the Contrast 
value (see Filter Setup). 

- the shape of each peak is defined in the Filter Setup window. 

- the width of a peak is a predefined constant value or can be estimated by the program (see Filter Setup) 

Fit Setup 

 
The fit setup window lets you define all important fit parameters. 
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Parameter Range Comment 

Dmax 0 < Dmax (1E+09) Search radius of the fit coefficient. The fit algorithm will be 
stopped with an error message if the difference between 
current fit coefficient value and initial value is greater than 
Dmax 

SOS-slope 0 < SOS-slope (0.01) Convergence criterion for the Sum Of Squares. 
Convergence is achieved, if the relative alteration of SOS 
between two consecutive iterations is less than SOS-slope 

DiffStep 0 < DiffStep (0.01) Relative change of the fit coefficient for calculating the 
partial derivative of the fit function 

min-SOS 0 < min-SOS (0.001) Convergence criterion for SOS. Convergence is achieved, if 
SOS is less than min-SOS 

maxDmpg 0 < maxDmpg (5) Maximum degree of damping for the fit algorithm 

MaxFun 1 < maxFun (100) Maximum number of calls to the fit function. If the number of 
fit function call becomes greater than MaxFun, the fit 
algorithm stops with an error message 

Fit-Wght 1, SQRT(Y) (1) This parameter controls the weighting of the data points. 
You can select either 

1  no weighting 

or 

SQRT(Y) intensity weighting (every data point is weighted 
with the value of the square root) 

MinIntensity 0 # MinIntensity # 100 The Auto Input function will ignore all data points less than 
MinIntensity. MinIntensity is given in units of percentage of 
Ymax - Ymin 

Contrast 0 < Contrast # 100 This parameters controls the detection of a peak by the 
Auto Input function. A peak is detected, if the difference 
between a local maximum and the next minima is greater 
than Contrast. Contrast is given in units of percentage of 
Ymax - Ymin 

Shape Lorenzian, Gaussian The shape of (all) peaks (used by the Auto Input function) 

PeakWidth 0 < PeakWidth, auto Initial value for the peak width. In auto mode, the Auto Input 
function will estimate the initial peak width from the intensity 
slope. 

Beep On Error  A fit error will be indicated by a beep signal if this check box 
is marked. 

With the Default command you can reset all parameters to default values. 

Calculating Fit 
The fit algorithm is started with the Calculate command button in the fit control window. During the calculating process 
the Fit Status window is displayed. 
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Following status and error messages are possible: 

Fitting 

The calculating is active. 

Fit converged due to slope criteria 

The calculation was successfully finished. The relative change of the sum of squares between two iteration steps is less 
than SOS-slope. 

Fit converged since sum of squares small enough 

The calculation was successfully finished. The sum of squares is less than min-SOS 

Fit unsuccessful, sum of squares no longer decreases 

The calculation was cancelled, because any variation of the fit coefficients does not decrease the sum of squares. 
Increasing parameter DiffStep can solve those problem. 

Fit unsuccessful, too many function calls 

The calculation was canceled, because the algorithm needs more than MaxFun fit function calls to achieve the 
convergence criterion. The MaxFun parameter works as a time out criteron. If a convergence is recognizable in the plot 
window, you should increase the MaxFun value. If you see no convergence, please check your initial fit coefficient 
values. 

Fit unsuccessful, no solution within given convergence radius 

At least one of the calculated fit coefficients is outside a certain range (Dmax) around the initial value. With Dmax you 
can restrict the range for a fit coefficient to avoid nonsensical values. 

Fit unsuccessful, Jacobian matrix is singular 

No calculation possible. Check your initial values. There must be more data points than fit coefficients. 

Fit unsuccessful, there is no parameter to fit 

No calculation possible. The number of fit coefficients is zero or they are declared as constants. 

Fit unsuccessful, there is no data to fit 

There are no selected data points to fit. 

Fit Result 
The result of the fit can be shown graphically in the plot window. The calculated fit coefficients are listed in the list field of 
the fit control window. The estimated fit values are written to the worksheet. By pressing the Show Result command 
button the program creates a summary in a text window. The summary can be saved or printed out or copied to the 
clipboard within the text edit window.  

A summary from the example shown above is listed here: 
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Peak Integrate 
This function calculates the area under a curve between two selectable data points.  

1. Select a single data column for this function 

2. Click on command Peak Integrate in the worksheet Math menu 

A new plot window is created, showing the selected column data as a line plot. The Result window is also opened, 
showing an empty text box. You can recognize the Peak Integrate mode by the pressed toolbar button:  

 
The Mouse cursor is changed to a red cross. 

3. Select the integration range 

- Move the mouse to the starting point of the curve, from where the integration should begin and clock and hold the 
left mouse button. The program will calculate the data point (Row1, X1, Y1), which is next to the mouse position. 
A red line is shown as a guideline. 

- Drag the mouse to the end of the integration range and release the mouse button. The program again calculates 
the next data point (Row2, X2, Y2) 

The area A0 between the curve and the X-axis is calculated with the formula: 
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The value of area A is written into the data column Area next to the right side of the source data column. If the 
Area column does not exist, the program will create this column. This column is automatically set as a Label 
column. When a Label column is plotted, the program uses the left data column - which must be set as a Y 
column - and the X column to calculate the position of the label. The contents of a Label column is interpreted as 
a text rather than a (possible valid) number.  

The Area column is plotted into the plot window.  

A detailed description of the performed peak integration is written into the Result window.  

 
4. Continue with step 3 for additional calculations. 

5. If you are finished with calculations, press the 

 button. 

Hint: It is possible to invoke the Peak Integrate function directly from a plot window by clicking on the Peak Integrate 
button in the toolbar. The info line shows the name of the source data column. The source data column is the leftmost 
selected column in the worksheet associated with the plot window. If no column is selected or the selected column is not 
plotted within the active plot window, the program will use the data column of the first plotted curve. 
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IV. Creating a video file from a sequence of single images 

With EE2000 you are able to create a video file (“Film”) from a sequence of single images. To do this, follow these steps: 

Open the Software Video Recorder dialog box by clicking click on the Open Film command in the File menu 

 
A file open box appears. Close this dialog box without selecting a file by clicking on the Cancel (Abbrechen) command 
button. 

 
The Software Video Recorder window is displayed without loading a file. 

From the File menu in the Software Video Recorder call the Import command. 

 
A file open box for selecting an image files is shown. 
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In this example you see image files, which were exported from the sample video file coming with this software. You can 
also list the files by displaying a thumb nail of every image in the file open box. 

 
Select all image files, which you want to have in the video file. In the example select from file si7x7_000.tif to 
si77x7_120.tif as shown in the next figure. 

 
Click on the Open (Öffnen) command button.  

In this example, the image sequence was recorded with a starting energy value of 30eV. The energy value was 
increased by 1eV with every recorded image. The image sequence can be saved by adding the energy information into 
the video file (only possible when using the .vid file format). 

Enter the energy vale of the first image and click on OK: 

 
Enter the energy step value and click on OK: 
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In the next safe file box you must enter the file name of the video file. Use the *.vid file format, if you want to add the 
energy information to the video file. 

 
Click on Save (Speichern).  

The EE2000 software loads one image file after another and save the image data to the video file. Note, that the image 
sequence is sorted alphabetically. So, image file “pic_3.tif” is loaded after image file “pic_10.tif”. Keep this in mind and 
use leading zeros for small image numbers: “pic_003.tif” and “pic_010.tif”. Depending on the image size and number of 
image files this process can take some time. When finished, the created video file is opened and the first image is 
shown. 

 
With the Info menu command you can get some information regarding the current image of the vide file. 

 
From this dialog box you can create a work sheet with all the data information additionally saved in the video file: 
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With a video file open, you can do experiments (like measuring I(V) curves), as if the image data came from the grabber 
and the energy value were measured with an ADC-interface board. Note: if a video file is opened, the grabber is not 
used as an image source for experiments. Instead the video file is the image source. 
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V. Das Stresscounter Modul (Riss 2000) 

 

 

 

 

Das Stresscounter Modul generiert ein Trigger Signal in Abhängigkeit des gemessenen Spannungsverlaufs einer 
Analogspannung. Üblicherweise ist die Analogspannung proportional zur mechanischen Zugspannung (Stress), die auf 
die Probe einwirkt. Da die mechanische Belastung auf die Probe zyklisch wiederholt wird, ist das Stresscounter Modul 
auch in der Lage, die Zahl der Belastungszyklen zu registrieren. 

Das Stresscounter Modul ist ein separates Programm, so dass die Belastungszyklen auch dann registriert werden, wenn 
das Bilderfassungsprogramm EE 2000 gerade nicht läuft. Der Datenaustausch mit EE 2000 erfolgt über DDE (Dynamic 
Data Exchange). 

 

Installation 

Falls EE 2000 noch nicht installiert ist, tun Sie dies jetzt. 

Kopieren Sie alle Dateien aus dem Stresscounter Verzeichnis der EE 2000 CD in das Verzeichnis von EE 2000 
(üblicherweise C:\Programme\Ee2000\ 

Installieren Sie den Treiber für die mitgelieferte A/D-Wandlerkarte. (Siehe die Datei ReadMe.txt auf der Treiberdiskette) 

Starten Sie das Programm EE 2000 

Führen Sie den Befehl A/D-Converter im Menü Setup aus und wählen Sie als A/D-Interface ADCFile. 

Klicken Sie auf OK. 

Beenden Sie EE 2000 und starten Sie EE 2000 erneut. 

Starten Sie jetzt das Programm StressCounter.exe. Sie sehen das Programmfenster von StressCounter.exe: 
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Rufen Sie den Befehl Setup im Menü File auf: 

In der angezeigten Dialogbox wählen Sie Ihr Interfacemodell aus und klicken auf Accept. In der Statuszeile wird der 
Name des Interfaces angezeigt. Erscheint der Name in Klammern, so konnte das Interface wegen eines Fehlers nicht 
initialisiert werden. 

Wählen Sie jetzt den A/D-Wandlereingang, an dem die zu messende Spannung anliegt. Klicken Sie hierzu auf die 
Combo-Auswahlbox und wählen den entsprechenden Kanal. 

Die momentan an dem ausgewählten Kanal gemessene Analogspannung wird unterhalb der Combo-Auswahlbox 
angezeigt. 

Hinweis: Die Setup-Funktionen sind nur verfügbar, wenn keine DDE-Verbindung vorhanden ist. Beenden Sie also ggfls. 
das Programm EE 2000. Bei bestehender DDE-Verbindung kann das Programm nicht beendet werden. 

Beenden Sie nun StressCounter.exe damit die Einstellungen gespeichert werden. 

StressCounter.exe muss manuell zusätzlich zu EE 2000 gestartet werden. Durch den Start von EE 2000 wird 
StressCounter.exe nicht automatisch gestartet. 

 

Nächster Zyklus, der ein 
Triggersignal auslöst 

Anzahl registrierter Zyklen 
des momentanen Zyklus 

Überwachter 
A/D-Wandlereingang 

Momentane Spannung am 
A/D-Wandlereingang 

Anzahl Extrema 
pro Zyklus 

Anzahl registrierter 
Extrema 

Status der DDE-Verbindung 
Grau = nicht verbunden 

Grün = verbunden 

Installiertes A/D-Wandler-
Interface 
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Triggerung 

Mit dem Befehl Trigger im Menü Counter wird nachstehende Dialogbox angezeigt. 

 
Die Stresscounter-Software erkennt einen Zyklus an Hand von Extrema im zeitabhängigen Verlauf der gemessenen 
Analogspannung. Sie können auf Maxima oder auf Minima in der Analogspannung triggern. Ein Extremum wird als 
solches jedoch nur dann erkannt, wenn der Analogspannungswert oberhalb (bei Trigger on max. voltage) bzw. unterhalb 
(bei Trigger on min. voltage) des Threshold Spannungswertes liegt. 

Ein Zyklus kann mehrere gleichartige Extrema enthalten. Damit der Zykluszähler nicht falsch zählt (nämlich zu schnell), 
können Sie im Eingabefeld Extrema per cycle die Anzahl der Extrema pro Zyklus angeben. Dieser Zahlenwert erscheint 
in der rechten oberen Ecke des Displays. 
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Der Zykluszähler kann jederzeit auf einen beliebigen (positiven) Wert gesetzt werden. Geben Sie hierzu den neuen 
Zählerwert im Eingabefeld Counter value ein und drücken Sie Set. Der Zählerwert wird nicht durch drücken von OK 
gesetzt. Der augenblickliche Zählerwert wird links im Display in großen Zahlen angegeben. Die bereits registrierten 
Extrema des folgenden Zyklus werden rechts davon im Display angezeigt. Wird der Zählerwert neu gesetzt, so 
berechnet StressCounter.exe automatisch die Zyklusnummer, bei das nächste Triggersignal ausgelöst wird. Es werden 
hierzu die Einstellungen unter Profile benutzt. 

 

Profile 

Mit dem Befehl Profile im Dialog Trigger wird nachstehende Dialogbox angezeigt. 

 
Um die Zahl der Triggersignale vor allem bei lang andauernden Experimenten gering zu halten, können Sie in dieser 
Dialogbox definieren, in welchen Abständen (ausgedrückt in Anzahl Zyklen) ein Triggersignal erzeugt werden soll. Mit 
Default wird ein (fast) logarithmischer Abstand zwischen den Triggersignalen definiert. 

 

 

 

Tipps bei der Aufzeichnung von Risswachstum mit der EE2000 

Die folgende Beschreibung geht davon aus, dass die EE2000 Software nebst Hardware installiert sind. 

Die Aufzeichnung eines Risswachstumsexperiments erfolgt mit der Funktion Image Recorder im Menü Scan. 



 

Einstellungen auf der Registerkarte Sweep: 

 
Geben Sie einen Dateinamen an. Wählen Sie ein Verzeichnis auf einem Laufwerk mit genügend Speicherkapazität. 

Deaktivieren Sie das User Kontrollkästchen. 

Setzen Sie t.Start auf 0 s. (Es sei denn, Sie wollen das Experiment verzögert starten.) 

Setzen Sie t.Stop auf 0 s, wenn Sie das Experiment beliebig lange laufen lassen wollen (Abbruch erfolgt dann nur 
manuell oder bei einem Fehler.), oder geben Sie die Laufzeit des Experiments in Sekunden an. (1 Tag = 86400 s). 

Setzen Sie t.Step auf 0 s. 

Setzen Sie Dwell Time auf 0 s. 

Setzen Sie Averaging auf 1. 
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Einstellungen auf der Registerkarte A/D Channel: 

 
Aktivieren Sie das 1. Kontrollkästchen unter Record. (Die Nummer des aktuellen Zyklus wird wie eine Analogspannung 
behandelt.) 

Deaktivieren Sie das Kontrollkästchen unter Graphic 

Aktivieren Sie das Kontrollkästchen Enabled. 

 



 

Einstellungen auf der Registerkarte Options: 

 
Wählen Sie als Trigger Mode: Trigger every Step of Sweep. 

Wählen Sie als Trigger Source: File Trigger. 

Markieren Sie das Kontrollkästchen Update. 

Einstellungen auf der Registerkarte Video Source: 

 
Wählen Sie die Videoquellen, die Sie aufzeichnen wollen. Diese Registerkarte ist abhängig vom verwendeten Video 
Grabber. Falls der Framegrabber nur einen Videoeingang hat oder der Treiber eine programmgesteuerte Umschaltung 
nicht unterstützt, erscheint nur die Optionsschaltfläche Current Video Source. 
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Stehen mehrere Videoeingänge zur Verfügung (2 oder 3), so können Sie wählen, ob nur der momentan aktive 
Videoeingang als Videoquelle dient, oder ob nach jedem Triggersignal zu einem anderen Videoeingang umgeschaltet 
werden soll (z.B. Betrieb von 2 Kameras). 

 

Klicken Sie zuletzt auf Accept. 

 

Bevor Sie das Experiment mit Start starten, überprüfen Sie die Einstellungen in StressCounter.exe. 


